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1. Introduction 

Users can connect to the Click&DECiDE Web Portal installed on a Server machine, inside or outside your 
organization. All you need is Internet Explorer version 9 or greater. If you wish to run items such as Cubes, 
you will be prompted to install the Microsoft Office 2003 Web Components on your local computer. 

The following browsers are supported: Internet Explorer version 9 or greater, Google Chrome (except for the 
cubes), Mozilla Firefox (except for the cubes). User profiles are defined by the System Administrator via the 
Click&DECiDE Administration Manager tool. 

The new Click&DECiDE version 12.x and version 2013 provide a new way to create easy Dashboards using 
the Google Charts without the need to install nothing on the client workstation connected to the new Web 
Portal. Note that the use of the Google Chart Dashboards requires access to Internet and a browser such as 
Internet Explorer version 9 or greater, Google Chrome or Mozilla Firefox. 

The new Click&DECiDE version 12.x and version 2013 Web Portal has been designed to be run from an iPad, 
an Android tablet or smartphones such iPhone or Android phones. 

2. Connecting to the Web Portal 

To connect to the Click&DECiDE Web Portal, please follow the steps below: 

1. Open your Internet browser. 

2. Enter the following link: http://server_name/dvweb 

Note: the server_name can be the name of the server machine, the IP Address or a domain URL. 

3. Press Enter. 

4. Note: depending on the Click&DECiDE Web Server configuration, you will be prompted for a login 
unless Windows Authentication has been setup and depending on the Browser configuration. 

2.1. Connection as a Standard User 

In that case you do not belong to a Task Administrator group defined in the Click&DECiDE 
Administration Manager. 

2.1.1. Under Click&DECiDE Authentication 

You can use the proposed Guest account unless you have defined other Users. 

1. Enter the User Name: Guest 

2. Enter the Password: guest 

 

3. Click OK. 

2.1.2. Under Windows Authentication 

You do not need to Log in, except if your Browser configuration requires an Authentication. 

mailto:support@clickndecide.com
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Example: Under I.E.: go to Tools > Internet Options > Security then click “Local Intranet” and 
“Custom Level”, then go to the end of the list and check the option defined for “User 
Authentication”: a login can be required with the following option: 

 

 

 

And no login will be required with the following option or the option “Automatic logon with 
current user name and password”: 
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2.1.3. Standard Menus and Commands 

As you are not belonging to a Task Administrator Group, you only will see the authorized 
menus for the Group you belong to, defined by the System Administrator via the 
Click&DECiDE Administration Manager in the Server (Menu BAI Demonstration only), and the 
authorized commands will be the Browse button, the Configure button and the Create 
Button. 

 

From an iPad or Android Tablet or Smartphone only the right pane will be displayed. 

 

On the above screen, a Standard User only will access to the following commands: 

Click Browse to display the Menu List defined for the Group you belong to. 

Click Configure to customize this Home Page, see your Credential, manage your Data Source Logins and 
manage your Favorites. 

Click Create to open the Google Chart Dashboard Editor 
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2.2. Connection as a Task Administrator User 

In that case you belong to a Task Administrator group defined in the Click&DECiDE 
Administration Manager. 

2.2.1. Under Click&DECiDE Authentication 

You can use the proposed Admin account unless you have defined other Users. 

1. Enter the User Name: Admin 

2. Enter the Password: admin 

 

3. Click OK.  

2.2.2. Under Windows Authentication 

You do not need to Log in, except if your Browser configuration requires an Authentication. 

Example: Under I.E.: go to Tools > Internet Options > Security then click “Local Intranet” and 
“Custom Level”, then go to the end of the list and check the option defined for “User 
Authentication”. 

2.2.3. Task Administrator Menus and Commands 

As you are belonging to a Task Administrator Group, you will see the authorized menus for the 
Task Administrator Group you belong to, defined in the Click&DECiDE Administration Manager 
in the Server, and the authorized commands will be the Browse button, the Configure button, 
the Schedule button, the Create Button and the Publish button.. 

Note: as a Task Administrator, you are authorized to perform the Standard command plus the following 
commands: 

 Click Schedule to define or edit Schedule tasks, for example schedule the generation of a specific 
report, and sent this report to a list of recipients at the date and time you wish. 

 Click Publish to create and edit RSS Feeds, Highlights and Information feeds. 

 Click Configure to customize the Home Page, see your Credential and manage your Data Source 
Logins, see the users who are currently connected to the Web Portal and manage your Favorites. 

 

As you can see in our demo database installed with the software, the Admin User gets more menus than the 
Standard User (Menus BAI .Demonstration + BAI Tools + Web Portal Statistics): 
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Note that only users belonging to a Task Administrator Group can see the Schedule and Publish 
command, but also can see the Connected Users in the Configure command. 

 

2.3. Hiding the Banner or the Left Pane Menu list: 

 

It is easy make the left menu pane wider or narrower or hidden, as necessary (depending on the size 
of the report, query, cube or Dashboard you want to display in the right pane, or the length of a URL, 
report name you want to view in the left menu pane). You also can hide or show the Banner according 
the size you need to display Dashboards, Reports, Cubes etc. 

 

2.3.1. Modify the size or Hide the Left Menu Pane: 

To make the left Menu pane narrower: select the vertical bar and drag it to the left. 

To make the left Menu pane wider: select the vertical bar and drag it to the right. 

To hide the left Menu pane: click the vertical bar to hide the Left Menu pane. 

To show the left Menu pane: click the left vertical bar to show the Left Menu pane. 

2.3.2. Hide or Display The Banner: 

To hide the Banner: click the horizontal bar to hide the Banner. 

To show the Banner: click the horizontal bar to show the banner. 
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Click the Home Page icon to go back to the Home Page. 

Note: you also can directly get the Web Portal without Banner neither Left Menu List by replacing  

http://localhost/dvweb/ with http://localhost/dvweb/Home.aspx 

 

This is the mode used with iPad, iPhone or Android Tablets and Smartphones 

 

2.4. Logging Out of the Web Portal 

To log out of the Web Portal, just click the “Logout” button on the right of your [User-ID]: 
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You will be disconnected from the Server, allowing another user to login in your place. The number of users 
connected will depend on the License Certificate for the Server. The License Certificate can include a number 
of CALs (Client Access License for identified users) and/or a number of Concurrent Users. For Concurrent 
Users, when you disconnect, another Concurrent User can connect in your place. Note that you will be 
disconnected from IIS in the Server after a time out (the default time out is 10 minutes). 

 

This message will appear, allowing you to reconnect by clicking “Go back to the Home Page”: 

 

 

Note also that when a User is inactive more than the duration defined in the Timeout, he is automatically 
disconnected. When he clicks again to a Menu Item, he is automatically reconnected if the maximum number 
of users is not reached. 

 

2.5. Refreshing the Menu 

With the new Click&DECiDE Enterprise Version 2013 and greater, any new file located in a Shared Folder will 
automatically be displayed when accessing this shared folder. You do not need any more to refresh the Menu 
content as it was necessary with previous versions of Click&DECiDE. 

Nevertheless, if the Menu Structure has changed because you added a new shared folder or a new branch, 
etc. you need to refresh the Menu by disconnecting from the Web Portal and reconnecting again. 
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3. Configure  

 

3.1. View 

The View command enables any user (Standard Users and Task Administrator Users) to modify: 

- the Click&DECiDE Web Portal’s Theme (Background and Menu Look) 

- the language to be used 

- the date, time and numeric formats 

and enables any user to display or hide the product information when opening the Web Portal: 

 

 

3.1.1. Theme: 

Select the skin you want from the drop-down list. Several skins are available by default: 

 Click and DECiDE: the Click&DECiDE skin in green, grey and white. 

 

 

 

 Blue: a Blue skin. 
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 Darkness: a black background, and white text. 

 

 

 

 

 Metro:. a Windows 8 look, soft and flat. 

 

 

 

 Surf: an acid green, orange and pink skin with surf icons. 
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 Customize your Theme! 

You also can customize your Theme using “JQuery” doing the following steps: 

a) Start with any of the existing Theme (except the Metro Theme), for example start using the 
Click&DECiDE Theme. 

b) In the Server where Click&DECiDE Enterprise is installed, go to the directory: 
C:\inetpub\wwwroot\dvweb\App_Themes 

c) Copy the “Click and DECiDE” directory under a new name, for example “My Personal Theme”. 

d) Go to the C:\inetpub\wwwroot\dvweb\App_Themes\My Personal Theme\jquery.ui directory 

e) Open the jquery-ui-1.9.2.custom.min.css file with a text editor 

f) In the row number 4 select the link full beginning with http://jqueryui.com/themeroller/...... 

g) Paste this link into a browser and press Enter 

h) In the JQuery ThemeRoller you can customize the skin step by step using the “Roll Your Own” Tab or 
select an already prepared theme in the Gallery Tab: 

mailto:support@clickndecide.com
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i) Rool You Own: define yourself what you want to change (Font, Corner radius, Colors etc) 

j) Gallery: select the existing Gallery template that you wish to use. 

k) In both case, finish by clicking “Download theme” 

l) Select for example the “Sunny” Gallery Template and click the Download button just under the 
template picture: 

 
 

m) In the Download Builder screen, select the 1.9.2 option: 
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n) Keep Toggle All selected: 

 

o) In the  bottom of the page, replace “Sunny” with “custom” in the Theme Folder Name box: 

 

p) Click Download 

q) Save the “jquery-ui-1.9.2.custom.zip” file in a temporary directory 

r) Open the jquery-ui-1.9.2.custom.zip file and select inside the content of : 
C:\Temp\jquery-ui-1.9.2.custom.zip\jquery-ui-1.9.2.custom\css\custom 

Those means select and copy these 2 files and the image directory: 

 

s) Now go to the C:\inetpub\wwwroot\dvweb\App_Themes\My Personal Theme\jquery.ui directory 

t) Select and delete the following file and directory 
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u) Paste the directory and the 2 files copied in step “r” 

v) Go back to the Web Portal and Refresh it using <F5>. 

w) Now the new “My Personal Theme” will appear in the list: 

 

x) Select this Theme to use it. 

 

y) How to change the Banner and the Background pictures? 

Go to the C:\inetpub\wwwroot\dvweb\App_Themes\Darkness\Images directory for example to copy the 
following pictures: background.png, header.png, HeaderBckgd.png and logo.png 

Copy these 4 pictures into the C:\inetpub\wwwroot\dvweb\App_Themes\My Personal Theme\Images directory 

Check the result by refreshing the Web Portal 

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

19 
 

 

 

Business Application Intelligence | Manual 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 

 

(If you do not like the result, you also can modify these 4 pictures yourself, keeping the same size and file 
names). Refer also to our FAQ KBA223 

z) How to remove a Theme? 

Just remove the directory corresponding to this Theme in the C:\inetpub\wwwroot\dvweb\App_Themes 
directory and refresh the Web Portal. 

 

3.1.2. Language: 

Click the country flag for the language you wish the menus to be displayed in. The following 
languages are available: Spanish, German, English, Catalan, French, Italian and Russian. 

 

3.1.3. Date, Time and Numbers 

Select in the list the Country you need to format the date, time, timestamp and numeric data when 
they are not already formatted by the query, report or cube. This applies specially when using Web 
Queries links into an Excel spread sheet. 

 

3.1.4. Display Product Information 

You can disable or enable the Product Information frame that appears when connecting to the Web 
Portal. This frame will inform you if your version is up to date, or if a new version is available. 
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3.2. Authentication 

The Authentication command enables any user (Standard Users and Task Administrator Users) to see their 
credentials (User ID, Rights, Groups and Computer IP Address) and manage the Data Source Logins if 
needed. 

3.2.1. Windows Authentication 

If the Windows Authentication Mode has been defined in the Server, then you are a user identified 
in a Windows Group and you belong to the same Windows Group defined in the Click&DECiDE 
Administration Manager in the Server. The Authentication box will appear as follow: 

 

The Rights could be “User” if you do not belong to a “Task Administrator” Group or “Administrator” if 
you belong to a “Task Administrator” Group in Click&DECiDE Administration Manager. 
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The IP Address of your computer also appears here. 

3.2.2. Click&DECiDE Authentication 

If the Click&DECiDE Authentication Mode has been defined in the Server then the Groups are the 
one you belong to, defined in Click&DECiDE Administration Manager. The Authentication box will 
appear as follow: 

 

The Rights could be “User” if you do not belong to a “Task Administrator” Group or “Administrator” if 
you belong to a “Task Administrator” Group in Click&DECiDE Administration Manager. 

The IP Address of your computer also appears here. 

 

3.2.3. Manage Data Source Logins 

This feature allows the user to connect to a database that is not using the Windows credential and keep 
nevertheless the Windows Authentication for the Web Portal Access. For example, you have a distinct User-
ID and Password to connect to the iSeries and want to be under Windows Authentication in the Web Portal 
because the use of the Excel 2010 Power Pivot or Web Queries from any Excel requires this Authentication 
Mode. 

To add you own credential for the iSeries data source, do the following steps: 

Note that this data source must previously be defined in Click&DECiDE Administration Manager as a “Data 
Source Secured by Click and DECiDE”: 
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In the “Manage Data Source Logins” from the Web Portal, click “Add a new Data Source Login”: 

 

Select in the Data Source list your iSeries Data Source (only Data Sources secured by Click and DECiDE will 
appear). 

Enter your USER-ID and Password (Case sensitive). 

Validate with the green check box. 

The list of your Data Sources Logins will be updated: 

 

In the Click&DECiDE Administration Manager side, on the Server, your credential has been added in the User 
Tab (Press F5 to refresh if needed). The password is encrypted. 
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So, the access to the Web Portal will use the Windows Authentication (here User-ID is Administrator), but 
when running iSeries queries, cubes or reports, the iSeries Login (DIDIER + password) will be sent to the 
iSeries automatically. 

When your iSeries Login will change periodically, just come back here to update your new login using the 

most left icon  to edit the configuration. 

Of course, the use of “Data Source Logins” is not necessary when using a Data Source already supporting 
your Windows credential, such as Microsoft SQL Server for example. 

 

3.3. Connected Users 

At any time, the Administrator or other authorized users belonging to a Group being “Task Administrator” in 
Click and DECiDE Administration Manager can see all active users, and see if they are identified as CAL 
users (Client Access License) or Concurrent Users. 
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On the Top of this screen, the Administrator can see how many “Client Access License” (CAL) user(s) and 
how many Concurrent User(s) are connected and the maximum authorized users authorized by the License 
Certificate. 

Note that the number of licenses used for the “Client Access License” (CAL) corresponds to identified users, 
specified in the User Tab of Click and DECiDE Administration Manager and having the “CAL” option activated: 
example, in the picture below Pierre is a “CAL” User: 

 

And in the next picture Didier is not a “CAL” User and will appear as a “Concurrent User”: 

 

Note that it is not necessary to add the User “Didier” in that case in Administration Manager if using Windows 
Authentication if this user will never be declared as a CAL User. 

From left to right, this Connected Users screen displays: 

An icon allowing to remove the corresponding user (example a User who left the Company)  

License type: CAL (Client Access License) or Concurrent Users. 

Product: Web Portal or Connect. 

User Name: the connected user’s User ID. 

IP Address: IP of the connected user computer. (IPV4 or IPV6). 
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Lifetime: this information gives the date and time when the user will be disconnected if there is no activity in 
the Web Portal. (This only concerns Concurrent Users). 

Note: after 10 minutes without activity, a concurrent user is disconnected, whereas a CAL User still appears 
but their IP Address displays “Inactive”. The Lifetime displays the last lifetime that was valid before the 
timeout. 

Example 1: 

 

After a while, the User VIRGINIE appears as inactive. 

 

 

The VIRGINIE CAL user appears with an Unknown IP Address when inactive, this allows the same user to 
connect again from another PC with a different IP Address. 

 

Example 2:  

 

 

In the above screen, the user DIDIER is connected at the same time using a Connect data source and the 
Web Portal. That is why you see his IPV4 address and his IPV6 address separated by a slash. 

The reason is that the Web Portal can display both IP address types: IPV4 and IPV6, whereas Connect can 
only display IPV4. 

Note: the Administrator can disconnect anybody from this screen using the  Remove icon. This is useful if 
you want to remove a CAL user that no longer works in the Company. This user should then be removed from 
the Click&DECiDE Administration Manager and be replaced with a new user if necessary. 
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3.4. Favorites 

The “Favorites” are corresponding to the “Home Pages” from a previous version of Click&DECiDE. If you 
install Click&DECiDE 2013 above a previous version having existing “Home Pages”, you will see them in the 
Favorite frame. 

The Favorites frame enables you to display for example the result of a report in HTML or PDF format, or a 
Dashboard made with the Google Charts etc. 

A Favorite can display a Report or a Google Chart Dashboard that do not retrieve any data but are used to 
display a customized menu offering some URL link to other reports or to other Google Chart Dashboards. 

Important: in the URL copied to the clipboard, the server name could be localhost if you are working directly 
on the Server machine. For any URL to be used from a remote computer connected to the Web Portal Server, 
you need to replace localhost by the Server’s IP Address or Server Name, followed by the port number if 
different than  80. 

To access to the Favorite frame, click Favorites in the Configure command: 

 

 

3.4.1. Adding a Favorite 

You first need to copy the URL of the required Report, Dashboard or Cube etc. 

To do so, select the required item in the Menu as if you wish to run it. Example: select the 
Report “Date Keyword Report” in the Dynamic Report branch and select as parameter “This 
Month” and PDF format: 

 

 

Then click the Share button that will display all available links depending of the output 
formats specified in the Menu for this item: 
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Copy the proposed URL into the clipboard and go back to the Favorite frame. 

Click Add a Favorite in this screen: 

 

Enter a Title and paste the URL into the box but change localhost with the server name and 
add the port number if different than 80 or just use the URL starting at /dvweb/… etc. 

 

Note that the end of the URL finishes with __e=0, that means the report will not be run 
immediately. If you want this Favorite to be run immediately, change the __e=0 with __e=1 

 

Note that if you want this Favorite to be run without showing any parameters nor output 
formats nor the Abort button, change ShowParameters.aspx with Display.aspx (the __e=1 
will not be used): 

/dvweb/Menus/Display.aspx?__ma=BAI+Demonstration&__mi=2361&P_DATE_Keyword=0+months+ago&__f=PDF 
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Click Add. This message will appear: 

 

Click Finish. 
You first Favorite has been added, and two icons allow you to edit or remove this Favorite 

 

Note that you also can test the URL link by clicking on the URL in this box. 

Now, when accessing to the Home Page using the icon , you will see your Favorite as follow: 

 

Click directly this “Sales for current month” favorite to get the result in the output format defined in the URL: 
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3.4.2. Modifying a Favorite 

Access to the Favorite box through the Configure command. 

 

Click the Edit icon  to modify the required Favorite in the list. 

Make the required changes and click the green check icon to validate or the red cross icon to 
cancel. 

 

3.4.3. Removing a Favorite 

Access to the Favorite box through the Configure command. 

 

Click the Remove icon  to delete the required Favorite in the list. 

Click OK on the next message or Cancel. 

 

The selected Favorite is removed from the list. 
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4. Browse 

To run menu items, follow the steps below: 

 

1. Click the Browse command in the Web Portal. 

 

2. Select one of the Menus assigned to your profile.  

Note: the Menus depend on the Menus assigned to the Group you belong to, defined by your 
Administrator in the Click&DECiDE Administration Manager for the Server. 

3. Refresh the Menu by logging out and then login again, if necessary.  

 

4.1. Working with Menu Branches 

Menus can display the following items. 

4.1.1. Items that do not Require the Installation of Additional Components 

The following items do not need additional components to be installed: 

 A branch running a dynamic query, dynamic report, static query and static report. 

 A branch displaying a link to a file in the following formats:  PDF, Excel, Word or an URL link. 

 A branch, called a Shared Folder, displaying any file type or Click&DECiDE project files containing 
queries or reports (except cubes). 

4.1.2. Items Requiring the Installation of Additional Components 

The following menu items require the installation of additional components: 

 A branch running a Cube. 

 A branch, called a Shared Folder, displaying Click&DECiDE project files containing cubes. 

 In both cases, a Microsoft Web Component ActiveX should be installed. 
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4.1.3. Items Requiring the Installation of Additional Software 

The following items require the installation of additional software: 

 A branch running the Click&DECiDE Builder software: 

 

4.2. Running a Dynamic Item 

To run a dynamic item, such as a query, report or cube, please follow the steps below. The following 
explanation applies to a dynamic query, report or cube. The example will be given with a dynamic report. 

4.2.1. Exporting a Report in PDF Format 

To export a report in PDF format, please follow the steps below. 

1. Select Browse. 

2. Select BAI Demonstration. 

3. Select Dynamic Reports. 

4. Click the Demo Multi Criteria report. 

 

5. Note all the parameters required by this report are displayed. A default value or the IGNORE reserved 
word appears when no values are authorized. 

6. Select the values you wish, as appropriate. Click the down arrow to display the drop-down list (click 
Shift + Click or Ctrl + Click to select several values at the same time), or click the Calendar icon to 
display the calendar (for Date or Date Time fields), you can also enter values in the edit box.  

7. Click Ctrl+Click: to select non-contiguous values. 
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8. Click the green  button to validate or the red  button to cancel. 

9. Click Shift+Click to select contiguous values. 

 

10. Click the green  button to validate or the red  button to cancel. 

11. Select a keyword for the Date field: (please refer to the Keyword List at the end of this manual). 

 

12. Or click the Calendar icon to select a specific date or date time. 

 

13. Note the output formats authorized by the Administrator are displayed. The default output format is 
PDF (Acrobat Reader). 

14. Click Run if the current parameters are correct. The result will appear in the output format you 
selected. 
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4.2.2. Exporting to another Output Format 

1. Select the output format HTML or Other. 

2. Select the Other option button to view the list of additional output formats supported by Click&DECiDE 
if your Administrator has setup this menu branch to propose other formats. 

 

3. Click Run to get the report result in the specified output format, according to the parameter values 
you entered. In the example below we selected the Excel 2007 output format and above criteria with 
“Last Year” for the date. 

4. A message appears while running: 

 

5. Then a message ask you what to do with the generated Excel file: 
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Click Open or Save and open the file under Excel 2007, 2010 or greater. 

6. Click on the required Tab to go  back to the location you need: 

 

7. The Tab corresponding to the item name will display the last parameters and output formats used. 

Note: if you wish to IGNORE a parameter previously defined, clear the check box to the left of the value and 
the IGNORE reserved word will be restored. 

 

Note: sometimes a parameter can be mandatory and/or not editable according to the way it has been defined 
by the Report Author. 

Note: when entering several values by hand in an edit box, the separator value is a semi-colon. No additional 
quotes are required for text fields as the field type is known by the application. 

4.2.3. Stopping a running Job 

Since version 10.2.2, during the execution time, the Run button is changed to Abort, so that it is now possible 
to stop an execution in progress. The consequence is that you cannot click elsewhere on the Web Portal 
before the current run is completed or stopped. (Improvement of the Click&DECiDE Export Manager Service). 

 

It should be noted that two steps are required when executing a query: the FIRSTDATA that returns the first 
set of data and then the FETCH that returns a result of successive data packet. Cancelling the execution 
cannot be done until the return of FIRSTDATA, i.e. either during the recovery following blocks, either during 
the formatting of data (query, report and cube). Cancelling during FIRSTDATA is planned for version 11 of 
Click&DECiDE. 

4.2.4. Working with the Navigation Bar in a  Report in HTML Format 

If you export a report to HTML format which generates several pages then a special navigation bar appears. 
Follow the steps below for more information. This new navigation bar has been designed to work fine 
under an iPad, iPhone, or Android Tablet or Smartphones. 
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Move the Page Number cursor to right or left to reach a specific page number or just next page or previous 
page. 

Example using the Demonstration Menu 

1. Click the Report with URL link branch. 

2. Click the Sales with 3 levels branch. 

3. Click the Sales by Area and Distributor report in the right pane. 

4. Click Run to run it. A first report appears with a page for each Area. The Area field contains a 
hyperlink that can call another report giving more details about this area. 

 

5. Click the value you want, for example the Central value (or any other area on next pages) and the 
second report will appear in place of the first one. 
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6. Click the Back Button from your browser to come back to the previous report, then the Next Browser 
button to go back to the last report. 

 

 

7. Select an article code beginning with “02” in the PRODREF column. A third report for the ADULT 
family will appear in place of the current report. 
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8. Click the Back Browser button to come back to the previous report. 

 

4.3. Working with Useful Icons and Buttons 

4.3.1. Navigation icons 

 Home Page: sends you back to the Main Home Page. 

 

4.3.2. Export to File button 

 Export to File: exports the current report directly to a file without building the result in the 
Web Page. This avoids displaying the result and having to click Save As. It is particularly useful when running 
output formats such as ASCII, as it automatically generates an ASCII file on the disk. 

4.3.3. Save Task button 

 Save Task:  generates a task that can be scheduled later. If you are not recognized as a Task 
Administrator user, this button is hidden. A Task Administrator user is a user who belongs to a Group defined 
as “Task Administrator” in the Click&DECiDE Administration Manager on the Server. Only the Administrator of 
this module can modify the user status. 

4.3.4. Share Button Bar 
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 Share: generates the required links (URL) such as Web Link, Google® DataTable 

Datasource, Excel® WebQuery Datasource, QlikView® Script, Excel® Power Pivot or Click'n'Decide 

Builder Query. 

4.3.4.1. Web Link: 

This link can be used when defining a Favorite, or used inside a Google Chart or be saved as a 
Shortcut on your desktop. 

Note: an URL can finish by __e=0 if you do not want to run immediately the item or by __e=1 if you 
want to get the report result immediately. 

The Web Link URL proposes by default this kind of link: 

http://localhost/dvweb/Menus/ShowParameters.aspx?__ma=BAI+Demonstration&__mi=2492&__e=0 

where ShowParameters.aspx will display first the parameters list and the output formats available for 
this item. 

You can use Display.aspx instead of ShowParameters.aspx to not see the parameters list neither 
the Output formats and run directly the item if __e=1. Refer to the Technical Appendix. 

4.3.4.2. Google® DataTable Datasource: 

This link will be used when creating some Dashboards with the Google Charts. (Refer to the BAI 
Dashboard Google Chart User Guide V2013).  

4.3.4.3. Excel® WebQuery Datasource: 

This link will be used when using the WebQuery inside an Excel file. See the chapter about the 
WebQuery in this Manual and the Technical Appendix. 

4.3.4.4. QlikView® Script: 

This link will be used when using QlikView to generate the required QlikView script. 

4.3.4.5. Excel® Power Pivot: 

This link will be used when using the PowerPivot module from Excel 2010 or greater. See the chapter 
about the Power Pivot in this Manual. 

4.3.4.6. Click'n'Decide Builder Query: 

This link allows the user to copy and paste this link into a Click&DECiDE Builder project file and get 
automatically the corresponding query built inside this project. Useful when using Click&DECiDE Web 
Builder. 

 

4.4. Saving a Task 

4.4.1. Create a new Task 

To create a task, please follow the steps below. This example will use the Demo Multi Criteria report 
for the Last Month period. 

1. Select the Dynamic Report branch in the left BAI Demonstration menu. 

2. Click the Demo Multi Criteria report.  

3. Ignore all parameters except the Date. 

4. Replace the year with Last Month. 

5. Select PDF output format. 
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6. Click the Save Task button. 

7. General: enter a name for the Task. 

 

8. Source: note the Report information (New in version 2013): Menu Name, Item Name and Menu ID: 

 

9. Parameters status: the parameters default values can be changed again here and, optional, you can 
use the last option to generate a document for each distinct value of the specified parameter. 

 

If you want for example to get a different target directory and/or a destination different file name for each value 
of the AREA field, managed by the AREA_PARAM parameter, then select this option and this parameter: 

 

10. Destination: click the Browse icon  to define the Destination Directory. By default the Shared 
Folder (and sub-directories) can be used because all new files created in these directories can be 
accessed later via the Web Menu. The Shared Folder corresponds to the following default path on the 
Server: C:\Program Files\Click and DECiDE\BAI\DemoWeb\Shared Folder. 
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Example with the option to generate several documents for each value of the parameter AREA_PARAM: 

 

The variable #PARAM_ITERATE# is automatically proposed in the Destination directory (but can be removed 
if needed) and can be used also in the Destination File Name. This variable will take the distinct AREA 
values found according to the other criteria. (NORTH-WEST, ATLANTIC, SOUTH etc.). If you are not using 
this iteration option, anyway enter a file name according to the chosen output format, for example Sales for 
Last Month.pdf.  

11. Suffix: when a report is exported periodically, you can automatically get a dynamic name according to 
the chosen period. To do so, modify the name to “Sales for the Month_.pdf” to add an underscore 
between the file name and suffix, and click the Suffix drop-down list to select the appropriate suffix: 
if we are the 1

st
 September 2013... 

Suffix Result Comment 

None  No suffix will be added 

YY 13 The suffix will be the 2 digits of current year 

YY-1 12 The suffix will be the 2 digits of last year 

YYMM 1309 The suffix will be the 2 digits of current year and 2 digits of current month 

YYMM-1 1308 The suffix will be the 2 digits of last month’s year and 2 digits of last  month 

YYMM-1D 1308 The suffix will be the 2 digits of yesterday’s year and 2 digits of yesterday’s month 

YYMMDD 130901 The suffix will be the 2 digits of current year, 2 digits of current month and 2 digits 
of current day 

YYMMDD-1 130831 The suffix will be the 2 digits of yesterday’s year, 2 digits of yesterday’s month, 
and 2 digits of yesterday 

NNNN 0001 The suffix will be a number starting at 0001 to 9999 

 
Select for this example the YYMM-1 suffix: 

 

12. Post-Treatment (optional): you can decide to make an action such as “Send an e-mail”, ”Export to 
Google Doc”, “Roambi Exporting Services”, of feed some tables such as the Highlight Table, the 
Information Table or the RSS Feed Table, when the item is run through the Scheduled Task. 
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If you want to do so, select this option: 

 

 

13. Click Finish unless you wish to use optional command “Generate a VBScript” using the 
corresponding button (reserved to advanced users who wish to manage this task by hand by 
customizing this Visual Basic Script). 

4.4.2. Do a Post Treatment 

Do a Post Treatment allows you to decide which kind of actions must be done at the run time report. 

4.4.2.1. E-mail 

 

It is possible to send a file (for example a report) by e-mail to one or more recipients, only working with single 
generated file, such as PDF, Excel, ASCII, and so on. To do so, follow the steps below. 

When the generated files are multiple such as Cube HTML Export, the e-mail action only sends the file with 
the *.cub extension. This file can be used to refresh a cube using the other static files (*.hta, *.gif, *.xml etc.). 

When the generated files are multiple such as Query or Report HTML export, the e-mail action does not 
work because only one file is sent. This may be modified in a future version of Click&DECiDE BAI.  

1. Select the e-mail as Post-Treatment. 

2. Enter the sender e-mail address in the From field. 

3. Enter the Recipient(s) address in the To field (to enter several recipient addresses, separate each 
address by a semi-colon). 

4. Enter the message title in the Subject entry field. 
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5. Enter the message body in the Text entry field. 

6. Note that the Attachment field can use the =Destination() function to return the file name with the full 
path. Another function, called =FileName() can sometimes be used to only return the file name 
without the path. 

7. Note the generated file will automatically be attached to the e-mail using the predefined 
=Destination()  function that you can see in the Attachment edit box: 

8. Click Finish 

4.4.2.2. Export Google Doc 

 

You need a Goggle account, enter you e-mail address and password, and then specify the Google Drive 
(shared with other people) and File Name you wish to use. Note that this Post-Treatment has been done 
specially for the Excel output format. (single file) when exporting.to Google Doc. Click Finish when done. 

Example of Google Drive and File Names: 

 

 

In the above example /Public in the Collection box represents My Drive / Public (Shared) 

And /Filename are the above examples “customer” (shared), Invoice_12023 (shared) and Invoice_12024 
(shared). 
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4.4.2.3. Roambi Reporting Services 

 

Enter your Roambi Web Service URL, your login, the destination folder and file name. Click Finish when 
done. 

4.4.2.4. Export to Highlight and Information tables 

This feature is maintained only for compatibility with previous versions of Click&DECiDE but is not any more 
supported. 

4.4.2.5. Sending RSS Feed Alerts 

 

The document generated by the Scheduled Task can add a record in the RSS Feed Table located into the 
DataSetReport database installed in your SQL Server by Click&DECiDE. 

1. Select the RSS Feed Post Treatment. 

2. Enter the Title you want to be displayed in the RSS Title area. 

3. Enter the Description you want to be displayed in the RSS Description area. 

4. Enter the Link = Hyperlink(). This function will automatically generate the URL corresponding to the 
report file created so that the end user can open this report when clicking the RSS Title. 

5. Enter the Category so that you can classify your information in several categories, such as 
Brochures, Videos, Documentation, Price List and so on. This is optional. 

Note: Standard RSS Feed readers do not use User and Group. 

6. Click Finish when done. 

Any new Task will appear in the Web Portal as follow, in the Schedule Task Frame. 
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4.4.3. Modifying or Deleting a Task 

To view or modify or delete an existing task, please perform the steps below. 

1. Click the Schedule command in the Web Portal. 

 

2. Click Tasks 

3. Your tasks and default Click&DECiDE tasks will appear in the frame. (See previous above picture). 

4. To edit a Task, just click on the Task Name. The Task will be open. 

5. To delete a Task, just click on the right  icon and confirm. Note that a Task cannot be deleted if still 
used by a Scheduled Task. 

For more information, please see the Schedule section to learn how to schedule one or more tasks. 
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4.5. Running a Dynamic Cube 

To run a dynamic cube, please follow the steps below. In this section we will explain some specific commands 
that can be used once a cube is displayed. This example will use the following cube:  Cube 1 Sales by year 
and salesman,  

Note: Mozilla Firefox and Google Chrome Browsers do not support the Cube feature. 

 

1. Click the Dynamic Cube branch. 

2. Select the cube you want, in this example Cube 1 Sales by year and salesman. 

3. Ignore all the parameters to get three years. 

4. Click Run to run the Cube. 

5. Note you may be prompted to install an ActiveX Web Component if it is the first time you are running 
Cube from this PC. 

6. Click the plus sign to expand Date levels. 

7. Click the Area filter field to display only certain areas, please refer to the Cube User Guide for more 
information. 

 

 

 

8. Click the Chart Tab to display the Graph. 
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Click the down-arrow in the top left corner of the screen to display the specific Cube commands that are 
available in the Web Portal. The following context menu appears. 

 

New Grid View…: creates a new Cube tab to get another presentation of the available dimensions and 
measures. 

New Chart View…: creates a new Chart tab to get another graph presentation. A Chart can be linked to a 
Cube View or can be standalone. 

Rename View: allow you to rename a Cube View or Chart View. First select the View to be renamed, then 
use this command. 

Remove View: allow you to remove a Cube View or Chart View. First select the View to be removed, then 
use this command.  
Warning: if you are removing a Cube View linked to a Chart View, a message will appear explaining that the 
Chart View is linked to the Cube View and that you will also lose these views. 
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Click OK only if you accept losing both views. The above example concerns the “Cube 6 Sales by 
Year and by Salesman with 2 graphs”. 

9. Click Save Data and Presentation As to save your cube’s presentation and data.  
Note: if you customized your Cube must save it locally, otherwise the next time you connect to this 
Cube in the Web Portal, you will get the Cube presentation defined on the Server machine. 

10. Enter the File name. 

 

11. Click Save. 

Note: you can now access this cube offline, without needing to connect to the Web Portal. To do so, go to the 
destination directory and double-click the *.hta file (in this example, the file mycube1.hta). 

 

4.5.1. Updating a Dynamic Cube 

To update a cube later with new data, please follow the steps below. 

 

1. Connect to the same cube via the Web Portal, for example, every day. 

2. Run the same cube to get new data. 

3. Select Save Data As and you will be able to save the new data in the same destination directory.  
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4. Click Save. 

 

 

 

5. Click Yes 

 

6. Click OK. 

7. Disconnect from the Web Portal. 

8. Double-click the mycube1.hta file to open your customized cube with the refreshed data. 

 

4.5.2. Exporting a Cube to Excel 2007 

Since version 10.1 a cube can be exported to Excel 2007 (or greater) if the new output format Excel 2007 
Pivot Table appears. Select for example the “Cube 1 Sales by Year and Salesman” in the Dynamic Cubes 
branch: 
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1. Select the Excel 2007 Pivot Table output format 

2. Click Run to send the Cube Data to Excel 2007 (or 2010 or greater). 

 

Note: this action cannot concern the Chart Tab. 

If this output format is not visible, refer to the Click&DECiDE Administration Manager Guide.pdf to see how to 
add this output format for a cube, on paragraph 6.6.4. 

Warning: the  icon that you can see in the cube result has not the same function as the Excel 2007 Pivot 
Table output format. 

This icon only can work to send a cube to Excel when using a Cube Analysis, not when using a file having 
“cub” extension. 
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4.6. Running a Web Query 

A Web Query is a query sent to a specific Click&DECiDE output format, named a WebQuery, generate a 
special URL that can be used later in any Excel file (Excel 2003, Excel 2007) to retrieve the data from the 
query from the Web (i.e. the Internet) without any Click&DECiDE software or components installed. 

Warning: this feature only works if the Click&DECiDE Web Server has been setup using Windows 
Authentication. 

4.6.1. Running a Predefined Example with Excel 

To run a predefined example of a Web Query with Excel, please follow the steps below. 

1. Click the Excel Integration > WebQuery branch in the left BAI Demonstration Menu. 

 

2. Click one of the predefined example files, that is either Web Query Excel XLS or Web Query Excel 
XLSX in the right pane. 

3. Open the file in Excel.  

4. Note that depending on your Windows version, you may need to click the Options button and click 
Enable this content. 

 

5. Click OK and this example should appear as follows. 

 

6. Modify the date using a year, or a keyword. 
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7. Modify the Area box using the proposed values (Atlantic, Central, North-West, South, West). 

8. Validate to update the Excel sheet using data from the Click&DECiDE Web site. 

9. Enter your User Name (ClientSaas by default). 

10. Enter the Password: demo. 

 

11. Click OK. 

12. Modify the year value, for example for Q1 2013 (or the current or last year) 

13. Modify the Area value for example for Atlantic. 

14. Validate, and the Excel sheet will be updated as follows. 

 

Important note: if the date or numeric formats are not correct in your Excel file, you can edit the Query Link 
and replace for example the end of the URL &__lg=fr-FR&__f=WebQuery with &__lg=en-
GB&__f=WebQuery to get an English format. 

Note that when you will build your own WebQuery, be sure to use the correct format in the Configure> View> 
command: the chosen format will build the correct syntax in the URL.
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4.6.2. Defining your Web Query Example 

4.6.2.1. Generating the Web Query URL 

To generate the Web Query URL, please follow the steps below. 

1. Click the Excel Integration > WebQuery branch in the left BAI Demonstration Menu. 

2. Select the Web Query Demo query. 

 

3. Select the Date criteria but do not select any values for this parameter. 

4. Select the Area criteria but do not select any values for this parameter. 

 

5. Click the  button. 

 

6. Copy the URL from the box at the right of “Excel WebQuery Datasource” 

7. Note, the link will look something like the following example:  

http://localhost/dvweb/Menus/Query.ashx?__ma=BAI+Demonstration&__mi=2364&P_DATE=["P_DA
TE","P_DATE"]&P_AREA=["P_AREA","P_AREA"]&__lg=fr-FR&__f=WebQuery 

or 
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http://servername/dvweb/Menus/Query.ashx?__ma=BAI+Demonstration&__mi=2364&P_DATE=["P_
DATE","P_DATE"]&P_AREA=["P_AREA","P_AREA"]&__lg=fr-FR&__f=WebQuery 

8. Note that criteria are transmitted as Parameters and not as Values. 

 

4.6.2.2. Building an Customized Excel Page 

To build an Excel page, please follow the steps below. 

1. Open Excel. 

2. Create a new document.  

3. Enter the word “Period” in cell A2 

4. Enter the word “Area” in cell A3 

5. Set the mouse cursor in cell B5 for example. 

6. Select the Data tab. 

7. Click the From Web button. 

8.  

 

 

9. Paste your WebQuery URL into the Address field in the New Web Query dialog box. 

 

 

 

10. Click Go and wait until the data are displayed: 
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11. Click Import and select the Cell B5. 

 

12. Click OK to confirm the starting cell. 

 

13. Select the cell B2 for the Date parameter and activate the options “Use this value/reference for future 
refreshes” and “Refresh automatically when cell value changes”. 

14. Click OK. 
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15. Select the cell B3 for the Area parameter and activate the options “Use this value/reference for future 
refreshes” and “Refresh automatically when cell value changes”. 

16. Click OK. The data will feed the sheet starting in cell B5, first row including the column headers: 

 

17. The link appears and then replaced with the result from cell B5 as follow:  

 

18. Note the result appears in the Excel sheet, starting at cell B5. 

19. Now enter a date keyword or a year (current year or last year) in cell B2 and press Enter. The result 
will be refreshed for the concerned value: 

 

Note: as you can see in the above screen shot, data are updated from Cell B5 and previous data has been 
removed. 
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20. Now enter one or several Area names in cell B3 and press Enter. The result will be refreshed for the 
concerned value: (Atlantic;Central;North-West;South;West  with semicolon as separator) 

 

Note: as you can see in the above screen shot, data are updated from Cell B5 and previous data has been 
removed. 

Date Keywords for the Period can be any keyword supported by Click&DECiDE such as a year, a month, Q1 
to Q4 for the current year or Q1 to Q4 followed by a year, or Last Month, Last Week etc. (see all supported 
keyword at the end of this manual). 

 

21. Editing again the link: make a right mouse click anywhere in the data area then select Edit Query: 

 

You can here paste a new URL link or modify the one used. 

22. Modifying the parameters: make a right mouse click anywhere in the data area then select 
Parameters: 
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You can here modify how parameter values are updated. 

23. Other options are available in the command Data Range Properties: 

 

 

4.6.3. How to use an URL bigger than 255 characters with WebQuery and Excel 

Form the Click&DECiDE Web Portal you can copy the WebQuery URL corresponding to a Query and paste 
this URL inside Excel using the command Data > From Web as describe previously. But the URL cannot be 
used if the size is bigger than 255 characters. 

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

58 
 

 

 

Business Application Intelligence | Manual 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 

A workaround is given in this Manual to be able to use WebQuery URL bigger than 255 characters. 
This manual will gives an example using the Demo_Multicriteria query given in the BAI Demonstration Menu. 

4.6.3.1. Select the Query to be used and copy the WebQuery URL  

To generate the Web Query URL, please follow the steps below. 

1. Click the BAI Demonstration menu in the Web Portal. 

2. Select the Dynamic Queries branch. 

3. Select the “Demo Multicriteria with parameters” query. 

 

To get a very long URL we are going to defined several values for the Area parameter and the Salesman 
Name parameter, such as this example: all areas are selected and all salesmen are selected. Only the Date 
parameter remains selected but empty: 

 

4. Now click the  button. 

5. Copy the Excel WebQuery Data source link. 

6. Optional: you can paste this URL into an editor to check the length: this one is 423 characters! 

http://dch-
t2008r2/dvweb/Menus/Query.ashx?__ma=BAI+Demonstration&__mi=2274&AREA_PARAM=ATLANTIC%3b
CENTRAL%3bNORTH-
WEST%3bSOUTH%3bWEST&SALNAME_PARAM=Bill+Raley%3bDiane+Meyer%3bDoug+Castro%3bGeorg
es+Dunel%3bJames+Smith%3bJean+Martin%3bJim+Baxter%3bJoe+Kramer%3bJohn+Brown%3bKaren+Wa
lker%3bKim+Johnson%3bRic+Smith%3bRobert+Salta%3bSandra+Davis%3bTim+Rosenberg%3bWanda+Sa
nders&P_DATE=["P_DATE","P_DATE"]&__lg=fr-FR&__f=WebQuery 

4.6.3.2. Transform this URL using TinyURL 

7. Open a new window in your browser and copy this URL: http://tinyurl.com/create.php 
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8. Copy the WebQuery URL in the “Enter another long URL to make tiny” box and click the 
Make TinyURL! Button. You will get the result as follow: 
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Copy the new URL into your clipboard, using the [Copy to clipboard] link. Note that the short URL 
has been copied to your clipboard automatically. If you lost it, or if you did not click Allow access 
to the previous message, you can manually copy again the above dynamic URL such as this 
example: http://tinyurl.com/lwnuyxt 

4.6.3.3. Use the TinyURL in Excel to import the WebQuery: 

To build an Excel page, please follow the steps below. 

9. Open Excel. 

10. Create a new document.  

11. Go to the cell B5 for example. 

12. Select the Data tab. 

13. Click the From Web button. 

14. Paste your TinyURL into the Address field in the New Web Query dialog box. 

 

15. Click Go 

16. Click Import once the data are displayed 

 

As you can see the TinyURL has been changed to the full big URL, then the WebQuery will work fine. 

17. Select the target top left corner for the data result, example cell B5: 
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18. Click OK to confirm the starting cell. 

19. As the Date is an empty not defined parameter, you will get this dialog: 

 

20. Click the cell B2 to define the location for the Date parameter value.  

21. Validate and check on the 2 options: 

 

22. Click OK. 

23. The result will appear from cell B5 on the rows below and right columns 

 

 

 

24. Any date value, or date keyword, entered in cell B2 will refresh the data 
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4.7. Running a PowerPivot with Excel 2010  

Requirements: Excel 2010 must be installed as well as the Power Pivot module. This module can be installed 
above your Excel 2010 version or greater. 

4.7.1. Step 1: defining the tables you need in Menu Builder 

Open Click&DECiDE Menu Builder and add in a Branch all the required tables based on a query, as you can 
see in the DemoWeb.wmu file: to do so, add a dynamic query pointing to the Click&DECiDE Builder project 
file containing theses queries. 

 

In each query Properties, define in the General Tab the path to the Builder project file and the query to be run: 
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Then, on the Format Tab, add the ATOM output format: 

 

Click OK and save the menu. 

 

4.7.2. Step 2: Copying the ATOM URL link to be used in Excel 2010 

Open the Web Portal against the Server having the Click&DECiDE Web Server installed, and, if needed, enter 
your login: (depending on your Authentication Mode). Once connected to the Web Portal, select the branch 
containing all your required queries having the ATOM output format: 

 

 

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

65 
 

 

 

Business Application Intelligence | Manual 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 

Select the first query, corresponding to the “Sales” Table in the above example: 

 

Click the  button to get the PowerPivot URL: 

Note: if the ATOM format has been added in the Menu for this query, you automatically get the required URL 
using the Share button. 

 

Copy the URL from this box. 

http://dch-t2008r2/dvweb/Menus/Query.ashx?__ma=BAI+Demonstration&__mi=2492&__f=Atom 

4.7.3. Step 3: Adding the table content into the Excel Power Pivot Windows 

On the client workstation, start Excel 2010 and open a new sheet. 

 

Select the PowerPivot Tab and click the PowerPivot Window icon: 

 

Click the From Data Feeds icon, then paste the URL in the Data Feed Url box 
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And change the Friendly connection name to an easier name: (table name for example): 

 

The Test Connection could work immediately if you are under Windows Authentication and recognized by 
the Server. In other case, you could need to specify the login to be used. 

To do so, click the Advanced button: 
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In the above dialog box: 

- change SSPI with Basic 

- Enter a valid UserID for the Server name visible in the URL 

- Enter a valid Password for this UserID 

- Change the Persist Security Info to True 
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Click Test Connection then click OK. 

 

Click OK twice to come back to the previous windows:  

 

and click Next 
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In the above screen, you also can give a friendly name for the Data Feed Content: we will use the Table 
Name: (it will be used as the Tab Name in the PowerPivot for Excel book: 

Press F2 to modify the Friendly Name and enter the Table Name for example: 

 

Click Finish 

Once the data have been transferred to Excel, you will get this dialog: 
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Click Close and repeat, if needed, all steps to add another table. 

Each time, the PowerPivot Windows for Excel will create a new tab, with the Friendy Name and the table 
content: 

 

Note that for any date, time or date time field found, some new dimension are created such as Year, Quarter, 
Month, Day etc. 

If we repeat the steps for the Salesman Table we get 2 Tabs inside the PowerPivot for Excel Book: 
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In the above screen, note the Refresh icon allowing to refresh data next time you will use this PowerPivot. 

4.7.4. Step 4: Defining the Join condition for several tables 

If more than one table is used, you must specify the join conditions between the tables. 

To do so, select the Design Tab in the previous screen: 
 

 
 
and click the Create Relation Ship icon: 
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Define the required relationship between two tables and click Create. 

To modify or add relationships, click the Manage Relationships icon: 

 

 

From here you can create, modify or delete a relationship. Click Close when finish. 

 

4.7.5. Step 5: Creating the PowerPivot in the Excel Sheet 
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In the previous screen, click the PivotTable icon to create the PowerPivot in the existing sheet or a new 
sheet: 

 

And select for example the “Chart and Table (Horizontal)” branch. 

 

If we select the $B$3 cell, this cell will be the most top left corner of the PivotTable area. Click OK to confirm: 

 

In the above screen, you see on the top right corner the dimensions and measures available for each table, 
and on the bottom right corner the boxes in which you can drag and drop the dimensions and measures that 
you need. 
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The Row Labels box will receive one or several dimensions that you want to see as rows. 

The Column Labels box will receive one or several dimensions that you want to see as columns. 

The ∑ Values box will receive one or several numeric measure(s) that you want to see in the data area of the 
Pivot Table. 

The Report Filter box can receive a dimension not visible in the Pivot Table, but used as a filter (criteria) to 
modify later what you want to see. 

Then you can define one or several Slicer(s), in a vertical and/or horizontal position. The slicers will display  
all available values as buttons allowing you later to click directly on the button(s) whose values should be 
displayed. 

Example with the above Sales and Salesman Tables with Vertical Slicers: 

 

In the above example, the Area have been defined as Column Labels and Salesman Name as Row Labels 

The TOTAL field has been added in the measures (∑ Values) 

The Year, Quarter, Month and Day are used in the vertical slicers. 

The currency format has been defined for the Sum of Total. 

Now, if you close the Field List and select only the Year 2013 by clicking on the Year slicer, you will only get 
data from the year 2013, and if you click on Quarter 2 you will only get data from Quarter 2 of the Year 2013: 
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As you can see in the above picture, all months and/or days having no data appear in a light blue grey color. 

Only years, quarters, months and days having data appear in a darker color. 

You also see that the items without data are set at the end of the list in each slicer square. 

You can modify this presentation using the following commands: 

Make a right mouse click on a slicer and select the Slicer Settings 

 

Here you can change some options to modify the presentation, for example remove the option “Show items 
with no data last” and click OK for all Date Slicers. The previous example will be as follow if you apply for 
Months and Days slicers (and if needed Quarter and Year): 
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Now the month numbers are always in the order from 1 to 12, even if there are no data some months. Same 
comment for the days. 

To cancel a slicer selection, just click the Red Cross with the filter icon in the slicer box: 

 

Save your Excel Sheet.xlsx to finish. 

Next time you will open it, you can refresh the table data, if needed, using the Refresh icon in the PowerPivot 
Window for Excel. 

You also can add Horizontal Slicers, example with the AREA and SALESMAN. 

If you click on WEST Area, only the vendors from this area will be displayed in the SALESMAN Slicer and the 
Graph: 

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

77 
 

 

 

Business Application Intelligence | Manual 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 
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5. Schedule 

We have already explained how to create a Task from a report (or query or cube) and have created a task 
named “MyReportLastMonth”. Note that the Tasks list contains standard tasks installed by Click&DECiDE 
Enterprise Edition as well as the tasks you have created, such as the MyReportLastMonth: 

 

This section explains how to schedule one or several tasks at the same time. To do so please follow the steps 
below: 

1. Click the Schedule command in the Web Portal (visible only if you belong to a “Task Administrator” 
Group on the Server). 

 

2. Click Scheduled Tasks on the above windows. The Scheduled Task List should appear as follow the 
first time as we provide a task to purge the Alerts Tables: 

 

5.1. Create a New Scheduled Task 

To create a new scheduled task, please follow the steps below. 

5.1.1. General 

1. Click the  button. 

Change the default Scheduled Task Name “New Scheduled Task “ to a new name (each scheduled 
task must have a distinct name) as the following example: 
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2. Select in the left Available tasks pane the task(s) you want to be performed by your scheduled task. 

3. Click the right button to add these tasks to the right Tasks to be run pane. 

4. Add a comment if necessary. This is optional.  

5. Clear the Active check box if you need to disable this task temporarily. 

5.1.2. Frequency 

6. Define the Frequency you need for the selected tasks from the following: 

Now (the task will run immediately between now and the next minute maximum). 

 

Note: select the Delete Task when Done check box if you do not wish to keep this scheduled task. 

Once (the task will run only once at the specified date and time). 

 

Specify the Start Date and Time, the task will be saved unless you decide to delete it later. 

Daily (the task will run every day starting at the specified date and time). 

 

Specify the Start Date and Time with the Calendar; the task will be saved unless you decide to delete it later. 

Specify an End Date if necessary. 
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Define whether the task must be run every day or every X days via the Run the Scheduled Task every x 
Day(s) check box. 

Every Week (the task will run each week starting at the specified day and  time). 

 

Specify the Start Date and Time, the task will be saved unless you decide to delete it later. 

Specify an End Date if necessary. 

Define whether the task must be run every week or every X weeks via the Run the Scheduled Task every x 
Week(s) check box. 

Specify which day(s) of the Week you need to run this scheduled task by selecting the day of the week check 
boxes as appropriate. 

Every Month (the task will run each month starting at the specified date and time). 

 

Specify the Start Date and Time, the task will be saved unless you decide to delete it later. 

Specify an End Date if necessary. 

Select which day of the month the task must be run (between 1 to 31). 

Select which day of the week (between Monday to Sunday) specifying the position of this day in the month 
(between First, Second, Third, Fourth or Last). 

Select the Run the Scheduled Task on the following Months check boxes as appropriate, by selecting the 
required months of the year. 

5.1.3. Repetition 

7. Define the Repetition if needed: 

For each frequency, you can specify if you need to repeat the scheduled task. 
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Repeat the Scheduled Task: check box. Enter an Interval for a time dimension in Minutes or Hours. 

Enter a repetition Duration in Hours and Minutes. 

5.1.4. Set Account Information 

 

Before saving the scheduled task, be sure the SYSTEM user account is correct for your situation. See next 
paragraph for more details. 

8. Click Finish to save the new Scheduled Task, that will appear in the list below: 

 

5.1.5. Working with the Scheduled Task Account 

When you run a task, the SYSTEM user account will be used by default. All scheduled tasks will be saved 
under the Local System account (note the Security Options in the Windows Task Scheduler on the server 
machine). 
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To use another user account or modify the settings, please follow the steps below. For example, if you wish to 
run the task under French regional settings rather than English regional settings, or if you wish to modify 
parameters for network security reasons. 

Before saving the Scheduled Task by clicking the Finish button; 

 

1. Enter the new Login in the Run As box 

2. Enter the Password. 

3. Click Finish at the base of the Scheduled Tasks Configuration pane in the Web Portal when all the 
required options are selected. The new scheduled task will appear in the left top list. 

4. Open the Windows Task Scheduler, select Start> Control Panel> Administrative Tools> Task 
Scheduler to see the modified Scheduled Task 

 

5. Press F5 if necessary to refresh the right pane of the Task Scheduler. 

5.2. Edit, Delete or Run Now a Scheduled Task 

To edit or delete a scheduled task, please perform the steps below: 

1. Click the Schedule command in the Web Portal (visible only if you belong to a “Task Administrator” 
Group on the Server). 
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2. Click Scheduled Tasks on the above windows. The Scheduled Task List should appear as follow the 
first time as we provide a task to purge the Alerts Tables: 

 

5.2.1. Edit: 

Click directly the Scheduled task name you wish to modify in the editor. 

5.2.2. Delete 

Click the  icon to remove this scheduled task. 

5.2.3. Run Now 

Click the  icon to run now the Scheduled Task (useful to test it after creation). 

 

5.3. Copy a Scheduled Task Shortcut 

Sometimes it could be useful to authorize someone not being a Task Administrator to be able to run a 

Scheduled Task: this is the purpose of the last right  icon: this URL can be copied into a Menu branch 
accessible from some users belonging to a Group displaying this Menu. (New feature of Click&DECiDE 2013). 

 

5.4. Working with SQL Tasks 

To work with SQL Tasks please follow the steps below. You can create an SQL Task to send an SQL 
command to a database. Note that this is reserved to advanced users and Administrators only. In this 
example we are going to view one of the tasks installed by default, Purge RSS Feed Table SQL Task. The 
Purge RSS Feed Table task contains an SQL command which runs an SQL Server procedure. This 
procedure will purge the required tables.  

Note: the database can be one of the Data Sources defined in the Click&DECiDE Administration Manager. 
(SQL Server, Oracle, iSeries, DB2/UDB, ODBC Database). 

1. Click the Schedule command in the Web Portal, the click the Tasks branch:  
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2. Select the Purge RSS Feed Table task. 

3. Note the Purge RSS Feed Table task is opened in the Task Editor. 

 

Note that if the User ID is empty, the program accepts an empty Password, because it could be a database 
under Windows Authentication. 

But if the User ID is not empty, the program also accepts the password to be empty or not empty when 
creating the task, but, later, when editing this task again, the program always remove the password and a 
warning message will advise the user that the password is empty, so that he has to enter it again if exists. 
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5.5. Creating Generic Tasks 

You can create a Generic Task to execute a program. Note this is reserved to advanced users and 
Administrators only. In the following example we will create a Generic Task which runs a VBS Script, named 
Export_Excel.vbs, located in the Click&DECiDE\BAI\Sample\Automation directory. 

To create a Generic Task, please follow the steps below. 

1. Click the Schedule command in the Web Portal, the click the Tasks branch:  

 

1. Click New Generic Task button. 

2. Enter the Task Name. 

3. Enter the Run Command. In this example a VBS Script, named Export_Excel.vbs will be run, the file 
is located in the following directory: Click&DECiDE\BAI\Sample\Automation. 

 

4. Click Finish. 

5. Note your new SQL Task appears in the Tasks branch in the left pane. 
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5.6. Running Successive Scheduled Tasks 

When you run a scheduled task, the program will run task after task. However, if a task returns an error, the 
task that follows it will not be run. For this reason we have created a program named D7CheckDay.exe that 
generates an error if the current day is different from the parameter. For example, “D7CheckDay.exe” 1 will 
stop all the remaining tasks in the Scheduled Task if we are not the first day of any month, and will continue to 
run the remaining tasks if we are the first day of the month. 

5.6.1. Run a task daily but only if first day of the month: 

 

This is useful when you wish to create a Scheduled Daily Task running successively: 

 the Consolidation, Aggregation and Purge tasks 

 followed by the Daily Report Generation task 

 then check if we are the first day of the Month 

 then, if true, run the Monthly Report Generation task, or if false stop the procedure. 

 “D7CheckDay.exe” 31 will check if we are the 31st day of the month 

5.6.2. Run a task Daily but only if Last Day of the Month 

 however “D7CheckDay.exe” -1 will check if it is the last day of the month (ex: 28
th
 of February, 31

st
 of 

March), for example: 

 

 

 

 

  

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

87 
 

 

 

Business Application Intelligence | Manual 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 

6. Publish 

The Publish menu enables you to access the tables where the Alert information is saved (Information, 
Highlight and RSS Feeds). You can consult the table content, and create new records or deleted obsolete 
records from the Publish menu. 

If an alert generated by a report or a scheduled task is supposed to add or update a record in one of these 
tables, then you can consult the Publish box to check if the expected record has been added successfully. 

 

6.1. Working with the RSS Feed Table 

You can distribute information via RSS Feed, to do so, please follow the steps below. 

1. Click the RSS Feed icon in your navigator bar or enter the following URL in your browser: 

http://servername/dvweb/dvrss.ashx 

 

Note: if you want to use RSS Feed under the Chrome browser, you need to install this extension: 

https://chrome.google.com/webstore/detail/rss-subscription-extensio/nlbjncdgjeocebhnmkbbbdekmmmcbfjd 

2. Note the Click and DECiDE RSS feed appears: 
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3. Click Subscribe to this feed if you want to add this RSS Feed to your Feed Headlines gadget. 

 

 

4. Click the Subscribe button 

 

5. Select the Publish command in the Web Portal 

6. Click  RSS Feed to create, edit or remove an RSS Feed from the RSS Feed Table.  
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6.1.1. Editing an RSS Feed 

To edit an RSS Feed, please follow the steps below. 

1. Click the  Edit icon to the left of the RSS Feed you wish to edit.  

2. Edit the parameters as necessary. 

3. Note the Date field’s content can be used by the Purge command later. 

 

4. Click the  OK icon to confirm.  

6.1.2. Creating a RSS Feed record 

To create an RSS Feed, please follow the steps below. 

1. Click RSS Feed in the Publish command in the Web Portal. 

2. Click the Add an RSS feed to publish button at the bottom of the RSS feed screen. 

3. Configure the parameters for the new RSS feed as appropriate. 

4. Note the Date field’s content can be used by the Purge command later. 

5. Note the Category text box can remain empty (Optional). 

6. Note: Standard RSS Feed readers do not use Users and Groups 

7. Click Add.  

6.1.3. Deleting an RSS Feed 

To delete an RSS Feed, please follow the steps below. 

1. Click RSS Feed in the Publish command in the Web Portal. 

2. Click the  Remove icon to the left of the RSS Feed you want to delete. A message will appear 
asking you to confirm. 
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3. Click OK. 

6.1.4. Purging Obsolete RSS Feeds 

You can purge obsolete an RSS Feed, whose date is older than a specified number of days. To purge an 
obsolete RSS Feed, please follow the steps below.  

1. Click RSS Feed in the Publish command in the Web Portal. 

2. Click the Purge existing RSS feeds button at the bottom of the RSS feed screen. 

3. Enter the Number of days to keep 

 

4. Click Purge. The success message appears under the Number of days to keep text box. 

 

5. Click Finish. 

6.1.5. Accessing your RSS Feed through your browser: 

Under Internet Explorer click this icon to access the RSS Feeds: 

 

Then: 

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

91 
 

 

 

Business Application Intelligence | Manual 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 

 

1.1. Working with the Highlight Feed Table 

The Highlight Feed Table still exists in the DataSetReport SQL Server database to ensure the compatibility 
with previous Click&DECiDE versions 10 or 11 but the WebParts feature using this table is not anymore 
supported by Click&DECiDE 2013. You can refer to the User Manual for; previous version at: 

http://www.clickndecide.com/sites/default/files/assets/files/resources/clickndecide_bai_web_portal_user_guide
_1.pdf 

To access now to this table, do the following: 

1. Click the Publish command in the Web Portal. 

2. Click Highlight Feed. 

 

6.1.6. Editing a Highlight Feed 

To edit a Highlight Feed, please follow the steps below. 

1. Click the Edit icon  to the left of the Highlight Feed you wish to edit. 
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2. Modify the fields as necessary. 

3. Note the Date field’s content can be used by the Purge command later. 

4. Click the  OK icon to confirm your modifications.  

6.1.7. Creating a Highlight Feed 

To create a Highlight Feed, please follow the steps below. 

1. Click Highlight Feed in the Publish command in the Web Portal 

2. Click the Add a Highlight feed to publish button at the bottom of the Information feed screen. 

3. Configure the parameters for the new Highlight feed as appropriate. 

4. Note the Date field’s content can be used by the Purge command later. 

5. Click Add. 

6. Click Finish. 

6.1.8. Deleting an Highlight Feed 

To delete a Highlight Feed, please follow the steps below. 

1. Click Highlight Feed in the Publish command in the Web Portal 

2. Click the  Remove icon to the left of the Highlight Feed you wish to remove. A message appears 
asking you to confirm. 

3. Click OK to continue. 

6.1.9. Purging Obsolete Highlight Feeds 

You can purge obsolete Highlight feeds, whose date is older than a specified number of days. To purge an 
obsolete Highlight Feed, please follow the steps below.  

1. Click Highlight Feed in the Publish command in the Web Portal 

2. Click the Purge existing Highlight feed button at the bottom of the Information feed screen. 

3. Enter the Number of days to keep. 
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4. Click Purge. 

5. Note the success message appears under the Number of days to keep text box. 

6. Click Finish.  

6.2. Working with the Information Feed Table 

The Information Feed Table still exists in the DataSetReport SQL Server database to ensure the compatibility 
with previous Click&DECiDE versions 10, 11 or 12 but the WebParts feature using this table is not anymore 
supported by Click&DECiDE 2013. You can refer to the User Manual for; previous version at: 

http://www.clickndecide.com/sites/default/files/assets/files/resources/clickndecide_bai_web_portal_user_guide
_1.pdf 

To access now to this table, do the following: 

3. Click the Publish command in the Web Portal. 

4. Click Information Feed. 

 

 

6.2.1. Editing an Information Feed 

To edit an Information Feed, please follow the steps below. 

5. Click the Edit icon  to the left of the Information Feed you wish to edit. 

 

6. Modify the fields as necessary. 

7. Note the Date field’s content can be used by the Purge command later. 

8. Click the  OK icon to confirm your modifications.  

6.2.2. Creating an Information Feed 
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To create an Information Feed, please follow the steps below. 

7. Click Information Feed in the Publish command in the Web Portal 

8. Click the Add an Information feed to publish button at the bottom of the Information feed screen. 

9. Configure the parameters for the new Information feed as appropriate. 

10. Note the Date field’s content can be used by the Purge command later. 

11. Click Add. 

12. Click Finish. 

6.2.3. Deleting an Information Feed 

To delete an Information Feed, please follow the steps below. 

4. Click Information Feed in the Publish command in the Web Portal 

5. Click the  Remove icon to the left of the Information Feed you wish to remove. A message 
appears asking you to confirm. 

6. Click OK to continue. 

6.2.4. Purging Obsolete Information Feeds 

You can purge obsolete Information feeds, whose date is older than a specified number of days. To purge an 
obsolete Information Feed, please follow the steps below.  

7. Click Information Feed in the Publish command in the Web Portal 

8. Click the Purge existing Information feed button at the bottom of the Information feed screen. 

9. Enter the Number of days to keep. 

10. Click Purge. 

11. Note the success message appears under the Number of days to keep text box. 

12. Click Finish.  
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7. Working with Date Keywords 

7.1. Invariant Predefined Functions 

Invariant functions are keyword or expressions that can be understood by Click&DECiDE whatever your PC’s 
regional settings language is. 

INVARIANT PREDEFINED FUNCTIONS 

Function 
Range 
for x 

Comment 

HOURS (Note: in INVARIANT mode, hours is always written in plural even if the value is x=0 or x=1). 

x hours ago   0 - 12 
The date time interval from the beginning of the hour specified in the past 
from XX:00:00 to XX:59:59. 

in x hours 0 - 12 
The date time interval from the beginning of the hour specified in the future 
from XX:00:00 to XX:59:59. 

since x hours 0 - 12 
The interval from the beginning of the hour specified in the past at 
XX:00:00 up to now. 

until x hours 1 - 12 
The interval from now to the end of the hour specified in the future at 
XX:59:59. 

DAYS (Note: in INVARIANT mode, days is always written in plural even if the value is x=0 or x=1). 

x days ago   0 - 7 The date of the day specified in the past from 00:00:00 to 23:59:59. 

in x days 0 - 7 The date of the day specified in the future from 00:00:00 to 23:59:59. 

since x days 0 - 7 
From the beginning of the date of the day specified in the past from 
00:00:00 up to now. 

until x days 1 - 7 
From now up to the end of the date of the day specified in the future at 
23:59:59. 

WEEKS (Note: in INVARIANT mode, weeks is always written in plural even if the value is x=0 or x=1). 

x weeks ago   0 - 7 
The date interval for the week specified in the past from YYYYMMDD 
00:00:00 to YYYYMMDD 23:59:59. 

in x weeks 0 - 7 
The date interval for the week specified in the future from YYYYMMDD 
00:00:00 to YYYYMMDD 23:59:59. 

since x weeks 0 - 7 
From the beginning of the first day of the week specified in the past at 
00:00:00 up to now. 

until x weeks 1 - 7 
From now to the end of the last day of the week specified in the future at 
23:59:59. 

MONTHS (Note: in INVARIANT mode, months is always written in plural even if the value is x=0 or x=1). 

x months ago   0 - 12 
The date interval for the first day of the month specified in the past from 
YYYYMM01 00:00:00 to YYYYMM31 23:59:59. 

in x months 0 - 12 
The date interval for the first day of the month specified in the future from 
YYYYMM01 00:00:00 to YYYYMM31 23:59:59. 

since x months 0 - 12 
From the beginning of the first day of the month specified in the past at 
00:00:00 up to now. 

until x months 1 - 12 
From now up to the end of the last day of the month specified in the future 
at 23:59:59. 

QUARTER (Note: in INVARIANT mode, quarters is always written in plural even if the value is x=0 or x=1). 
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q1 or Q1  
Uses the date interval for the First Quarter of the current year from 
YYYY0101 00:00:00 to YYYY0331 23:59:59. 

q2 or Q2  
Uses the date interval for the Second Quarter of the current year from 
YYYY0401 00:00:00 to YYYY0630 23:59:59. 

q3 or Q3  
Uses the date interval for the Third Quarter of the current year from 
YYYY0701 00:00:00 to YYYY0930 23:59:59. 

q4 or Q4  
Uses the date interval for the Fourth Quarter of the current year from 
YYYY1001 00:00:00 to YYYY1231 23:59:59. 

x quarters ago 1 - 4 
The date interval for the first day of the quarter specified in the past from 
YYYYMM01 00:00:00 to the last day of the same quarter at YYYYMM31 
23:59:59. 

in x quarters 1 - 4 
The date interval for the first day of the quarter specified in the future from 
YYYYMM01 00:00:00 to the last day of the same quarter at YYYYMM31 
23:59:59. 

qx 1990 <---> qx 2030 1 - 4 

Uses the date interval for the specified Quarter of the specified year from 
YYYY0101 00:00:00 to YYYY0331 23:59:59. (Note that the year can be 
between 1990 and 2030 in the current Click&DECiDE version 11.1.0 or 
greater). 

YEARS (Note: in INVARIANT mode, years is always written in plural even if the value is x=0 or x=1). 

x years ago   0 - 10 
The date interval from the first day of the year specified in the past at 
YYYY0101 00:00:00 to YYYY1231 23:59:59. 

in x years 0 - 10 
The date interval from the first day of the year specified in the future at 
YYYY0101 00:00:00 to YYYY1231 23:59:59. 

since x years 0 - 10 
From the beginning of the first day of the year specified in the past at 
YYYY0101 00:00:00 up to now. 

until x years 1 - 10 
From now up to the end of the last day of the year specified in the future at 
YYYY1231 23:59:59. 
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7.2. Standard Days and Months Functions By Language 

In the following table the first column is the same for Invariant or English, other available languages can be 
used according to your PC’s regional settings language: 

Invariant and 
English %s is a French German Spanish Catalan Italian Swedish 

Days  Jours Tags Dias Dies Giorni Dagar 

DAY FROM LAST WEEK 

last %s 
Day 
name 

%s semaine 
dernière 

%s letzter 
wochse 

%s semana 
pasada 

%s setmana 
passada 

%s settimana 
scorsa 

%s förra 
vecka 

DAY ON NEXT WEEK 

next %s 
Day 
name 

%s en huit 
%s kommender 
woche 

%s semana 
próxima 

de %s en vuit 
%s settimana 
prossima 

%s nästa 
vecka 

NEXT COMING DAY 

coming %s 
Day 
Name %s prochain nächster %s próximo %s proper %s %s prossimo nästa %s 

LAST MOST RECENT DAY 

most recent 
%s 

Day 
Name %s dernier letzter %s %s pasado %s passat %s scorso i %ss 

SINCE A DAY 

since %s 
Day 
Name depuis %s seit %s desde %s des de %s da %s sedan %s 

UNTIL A DAY 

until %s 
Day 
Name jusqu'a %s bis %s hasta %s fins %s fino a %s till %s 

Months  Mois Monaten Meses Mesos Mesi Månader 

NEXT MONTH ON NEXT YEAR 

next %s 
Month 
Name 

%s année 
prochaine 

%s kommendes 
Jahr 

%s año 
próximo 

%s proper 
any 

%s anno 
prossimo 

%s nästa 
året 

MONTH OF PREVIOUS YEAR 

last %s 
Month 
Name 

%s année 
dernière 

%s letztes jahr 
%s año 
pasado 

%s any 
passat 

%s anno 
scorso 

%s förra 
året 

NEXT COMING MONTH 

coming %s 
Month 
Name 

%s prochain nächster %s próximo %s proper %s %s prossimo nästa %s 

MOST RECENT MONTH 

most recent 
%s 

Month 
Name 

%s dernier letzter %s %s pasado %s passat %s scorso i %ss 

SINCE A MONTH 

since %s 
Month 
Name 

depuis %s seit %s desde %s des de %s da %s sedan %s 

UNTIL A MONTH 

until %s 
Month 
Name 

jusqu'en %s bis %s hasta %s fins %s fino a %s till %s 
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7.3. Other Hour Functions by language 

Invariant 
and English 

Range 
for x 

French German Spanish Catalan Italian Swedish 

HOURS   HEURES STUNDEN HORAS HORES ORE TIMMAR 

last hour  dernière heure Letzte Stunde hora anterior hora anterior ultima ora förra timmen 

this hour  cette heure  Diese Stunde   esta hora aquesta hora quest ora denna timme 

next hour  
prochaine 
heure 

Nächste 
Stunde 

hora siguiente hora següent prossima ora nästa timme 

0 hours ago   
/  this hour 

 
il y a 0 heures / 
cette heure 

Vor 0 Stunden 
/ Diese Stunde 

hace 0 horas 
/ esta hora 

fa 0 hores / 
aquesta hora 

0 ore fa  / 
quest ora 

0 timmar 
sedan / denna 
timme 

1 hour ago   /  
last hour 

 
il y a 1 heure / 
dernière heure 

Vor 1 Stunde / 
Letzte Stunde 

hace 1 hora / 
hora anterior 

fa 1 hora / 
hora anterior 

1 ora fa / 
ultima ora 

1 timme 
sedan / förra 
timme 

x hours ago   2 - 12 il y a x heures Vor x Stunden hace x horas fa x hores x ore fa   
x timmar 
sedan   

in 0 hours   /  
this hour 

 
dans 0 heures / 
cette heure 

In 0 Stunden / 
Diese Stunde 

en 0 horas / 
esta hora 

en 0 hores / 
aquesta hora 

in 0 ore / 
quest ora 

om 0 timmar / 
denna timme 

in 1 hour   /  
next hour 

 
dans 1 heure / 
prochaine 
heure 

In 1 Stunde / 
Nächste 
Stunde 

en 1 hora / 
hora siguiente 

en 1 hora / 
hora següent 

in 1 ora / 
prossima ora 

om 1 timme / 
nästa timme 

in x hours 2 - 12 dans x heures In x Stunden en x horas en x hores in x ore om x timmar 

since 0 hours   
/   since this 
hour 

 
depuis 0 
heures 

Seit 0 Stunden 
desde 0 
horas 

des de 0 
hores 

da 0 ore 
sedan 0 
timmar 

since 1 hour   
/   since last 
hour 

 
depuis 1 heure 
/ depuis la 
dernière heure 

Seit einer 
Stunde / Seit 1 
Stunde 

desde 1 hora 
/ desde la 
hora anterior 

des d'1 hora 
/ des de 
l'hora 
anterior 

da ultima ora 
/ da 1 ora 

sedan sista 
timme / sedan 
1 timme 

last x hours 2 - 12 
depuis x 
heures 

Seit x Stunden desde x horas 
des de x 
hores 

da x ore 
sedan x 
timmar 

until 1 hour  
jusque dans 1 
heure 

Bis einer 
Stunde / Bis 1 
Stunde 

hasta 1 hora / 
hasta la hora 
siguiente 

fins 1 hora / 
fins l'hora 
següent 

fino a 1 ora / 
fino a ora 
prossima 

till 1 timme 

until x hours 2 - 12 
jusque dans x 
heures 

Bis x Stunden hasta x horas fins x hores fino a x ore till x timmar 
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7.4. Other Day Functions by Language 

Invariant and 
English 

Range 
for x 

French German Spanish Catalan Italian Swedish 

DAYS   JOURS TAGS DIAS DIES GIORNI DAGAR 

yesterday  hier Gestern  ayer ahir ieri igår 

today  
aujourd'hui  / 
ce jour 

Heute hoy avui oggi idag 

tomorrow  demain Morgen mañana demà domani imorgon 

0 days ago   /   
today 

 
il y a 0 jours / 
aujourd'hui  / 
ce jour 

Vor 0 Tagen 
/ Heute 

hace 0 días / 
hoy 

fa 0 dies / 
avui 

0 giorni fa / 
oggi 

0 dagar 
sedan / idag 

1 day ago    /   
yesterday 

 
il y a 1 jour / 
hier 

Vor 1 Tag / 
Gestern 

hace 1 día  / 
ayer 

fa 1 dia / 
ahir 

1 giorno fa / 
ieri 

1 dag sedan 
/ igår 

x days ago 2 - 7 il y a x jours Vor x Tagen hace x días fa x dies x giorni fa 
x dagar 
sedan 

in 0 days  /  
today 

 
dans 0 jours / 
aujourd'hui  / 
ce jour 

In 0 Tagen / 
Heute 

en 0 días / 
hoy 

en 0 dies / 
avui 

in 0 giorni / 
oggi 

om 0 dagar / 
idag 

in 1 day   /   
tomorrow 

 
dans 1 jour / 
demain 

In 1 Tag / 
Morgen 

en 1 día / 
mañana 

en 1 dia / 
demà 

in 1 giorno / 
domani 

om 1 dag / 
imorgon 

in x days 2 - 7 dans x jours In x Tagen en x días en x dies in x giorni om x dagar 

since 0 days   
/ since today 

 
depuis 0 jours / 
depuis ce jour / 
depuis aujourd'hui 

Seit 0 
Tagen / Seit 
Heute 

desde 0 días 
/ desde hoy 

des de 0 
dies / des 
d'avui 

da 0 giorni / 
da oggi 

sedan 0 
dagar / 
sedan idag 

since 1 day   /  
since 
yesterday 

 
depuis 1 jour / 
depuis hier 

Seit 1 Tag / 
Seit Gestern  

desde 1 día / 
desde ayer 

des d'1 dia / 
des d'ahir 

da 1 giorno / 
da ieri 

sedan 1 dag 
/ sedan igår 

last x days 2 - 7 depuis x jours Seit x Tagen desde x días 
des de x 
dies 

da x giorni 
sedan x 
dagar 

until 1 day    /  
until tomorrow 

 
jusque dans 1 jour  
/ jusqu'à demain 

Bis 1 Tag / 
Bis Morgen 

hasta 1 día / 
hasta 
mañana  

fins 1 dia / 
fins demà 

fino a 1 
giorno / fino 
a domani 

till 1 dag / till 
imorgon 

until x days 2 - 7 jusque dans x jours Bis x Tagen hasta x días fins x dies 
fino a x 
giorni 

till x dagar 
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7.5. Other Week Functions by Language 

Invariant 
and 
English 

Range 
for x 

French German Spanish Catalan Italian Swedish 

WEEKS   SEMAINES WOCHEN SEMANAS SEMANES SETTIMANE VECKOR 

last week  
semaine 
dernière 

Letzte 
Woche 

semana 
pasada / 
semana 
anterior 

setmana 
passada / 
setmana 
anterior 

settimana 
scorsa 

förra vecka 

this week  cette semaine 
Diese 
Woche 

esta semana / 
semana actual 

aquesta 
setmana / 
setmana actual 

questa 
settimana 

denna 
vecka 

next week  
semaine 
prochaine 

Nächste 
Woche 

semana 
próxima / 
semana 
siguiente 

propera 
setmana / 
setmana 
següent 

settimana 
prossima 

nästa 
vecka 

0 weeks 
ago   /  this 
week 

 
il y a 0 
semaines  / 
cette semaine 

Vor 0 
Wochen / 
Diese 
Woche 

hace 0 
semanas / esta 
semana 

fa 0 setmanes / 
esta setmana 

0 settimane fa / 
questa 
settimana 

0 veckor 
sedan / 
denna 
vecka 

1 week ago  
/  last week 

 
il y a 1 semaine  
/ semaine 
dernière 

Vor 1 
Woche / 
Letzte 
Woche 

hace 1 
semana / 
semana 
pasada 

fa 1 setmana / 
setmana 
passada 

1 settimana fa / 
settimana 
scorsa 

1 vecka 
sedan / 
förra vecka 

x weeks 
ago 

2 - 7 
il y a x 
semaines 

Vor x 
Wochen 

hace x 
semanas 

fa x setmanes x settimane fa 
x veckor 
sedan 

in 0 weeks  
/  this week 

 
dans 0 
semaines / 
cette semaine 

In 0 Wochen 
/ Diese 
Woche 

en 0 semanas 
/ esta semana 

en 0 setmanes 
/ esta setmana 

in 0 settimane / 
questa 
settimana 

om 0 
veckor / 
denna 
vecka 

in 1 week   /  
next week 

 
dans 1 semaine 
/ semaine 
prochaine 

In 1 Woche / 
Nächste 
Woche 

en 1 semana / 
semana 
próxima 

en 1 setmana / 
propera 
setmana / 
setmana 
següent 

in 1 settimana / 
settimana 
prossima 

om 1 vecka 
/ nästa 
vecka 

in x weeks 2 - 7 
dans x 
semaines 

In x Wochen en x semanas en x setmanes in x settimane 
om x 
veckor 

since 0 
weeks   /  
since this 
week 

 

depuis 0 
semaines / 
depuis cette 
semaine 

Seit 0 
Wochen 

desde 0 
semanas / 
desde esta 
semana 

des de 0 
setmanes / des 
d'aquesta 
setmana 

da 0 settimane 
sedan 0 
veckor 

since 1 
week   /  
since last 
week 

 

depuis 1 
semaine / 
depuis la 
semaine 
dernière 

Seit 1 
Woche 

desde 1 
semana / 
desde la 
semana 
pasada 

des d'1 
setmana / des 
de la setmana 
passada 

da 1 settimana 
sedan 1 
vecka 

since x 
weeks 

2 - 7 
depuis x 
semaines 

Seit x 
Wochen 

desde x 
semanas 

des de x 
setmanes 

da x settimane 
sedan x 
veckor 

until 1 week  
jusque dans 1 
semaine 

Bis 1 Woche 
hasta 1 
semana 

fins 1 setmana 
fino a 1 
settimana 

till 1 vecka 

until x 
weeks 

2 - 7 
jusque dans x 
semaines 

Bis x 
Wochen 

hasta x 
semanas 

fins x setmanes 
fino a x 
settimane 

till x veckor 
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7.6. Other Month Functions by Language 

Invariant 
and English 

Range 
for x 

French German Spanish Catalan Italian Swedish 

MONTHS   MOIS MONATEN MESES MESOS MESI MÅNADER 

last month  mois dernier Letzter Monat 
mes pasado 
/ mes 
anterior 

mes passat /  
mes anterior 

mese scorso förra månad 

this month   /  
current month 

 
ce mois / mois 
en cours / mois 
courant 

Dieser Monat 
este mes / 
mes actual 

aquest mes 
/ mes actual 

questo mese denna månad 

next month  mois prochain 
Nächster 
Monat 

mes próximo 
/ mes 
siguiente 

proper mes / 
mes 
següent 

mese 
prossimo 

nästa månad 

0 months ago   
/  this month 

 
il y a 0 mois / 
mois en cours / 
mois courant 

Vor 0 Monaten 
/ Dieser Monat 

hace 0 
meses 

fa 0 mesos / 
aquest mes 
/ mes actual 

0 mesi fa / 
questo mese 

0 månader 
sedan / denna 
månad 

1 month ago   
/  last month 

 
il y a 1 mois / 
mois dernier 

Vor 1 Monat / 
Letzter Monat 

hace 1 mes / 
mes pasado 

fa 1 mes / 
mes passat / 
mes anterior 

1 mese fa / 
mese scorso 

1 månad sedan 
/ förra månad 

x months ago 2 - 12 il y a x mois Vor x Monaten 
hace x 
meses 

fa x mesos x mesi fa 
x månader 
sedan 

in 0 months   
/  this month 

 
dans 0 mois / 
mois en cours / 
mois courant 

In 0 Monaten / 
Dieser Monat 

en 0 meses 

en 0 mesos 
/ aquest 
mes / mes 
actual 

in 0 mesi / 
questo mese 

om 0 månader / 
denna månad 

in 1 month   /  
next month 

 
dans 1 mois / 
mois prochain 

In 1 Monat / 
Nächster 
Monat 

en 1 mes o 
"mes 
próximo" 

en 1 mes / 
proper mes / 
mes 
següent 

in 1 mese / 
mese 
prossimo 

om 1 månad / 
nästa månad 

in x months 2 - 12 dans x mois In x Monaten en x meses en x mesos in x mesi om x månader 

since 0 
months   /   
since this 
month 

 
depuis 0 mois / 
depuis ce mois 

Letzte 0 
Monate 

desde 0 
meses / 
desde este 
mes 

des de 0 
mesos / des 
d'aquest 
mes 

da 0 mesi 
sedan 0 
månader 

since 1 month    
/  since last 

month 
 

depuis le mois 
dernier / depuis 
1 mois 

Seit Letztem 
Monat / Seit 1 
Monat 

desde el 
mes pasado 
/ desde 1 
mes 

des del mes 
passat / des 
d'1 mes 

da mese 
scorso / da 1 
mese 

sedan 1 månad 
/  sedan förra 
månaden 

last x months 2 - 12 depuis x mois 
Letzte x 
Monate 

desde x 
meses 

des de x 
mesos 

da x mesi 
sedan x 
månader 

until 1 month   
/  until next 
month 

 
jusque dans 1 
mois / jusqu'au 
mois prochain 

Bis 1 Monat / 
Bis Nächster 
Monat 

hasta 1 mes 
/ hasta el 
mes próximo 

fins 1 mes / 
fins el mes 
següent 

fino a 1 
mese / fino a 
mese 
prossimo 

till 1 månad / till 
nästa månaden 

until x months 2 - 12 
jusque dans x 
mois 

Bis x Monate 
hasta x 
meses 

fins x mesos fino a x mesi till x månader 
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7.7. Other Quarter Functions by Language 

Invariant 
and 
English 

Range 
for x 

French German Spanish Catalan Italian Swedish 

QUARTER   TRIMESTRES QUARTALE TRIMESTRES TRIMESTRES TRIMESTRI KVARTAL 

Q1  T1 Q1 T1 T1 T1 K1 

Q2  T2 Q2 T2 T2 T2 K2 

Q3  T3 Q3 T3 T3 T3 K3 

Q4  T4 Q4 T4 T4 T4 K4 

Last Quarter  
trimestre 
dernier 

letztes 
quartal 

trimestre 
anterior 

trimestre 
anterior 

ultimo,trimestre 
förra 
kvartal 

This Quarter  ce trimestre 
dieses 
quartal 

trimestre 
actual 

trimestre 
actual 

questo,trimestre 
detta 
kvartal 

Next 
Quarter 

 
trimestre 
prochain 

nächstes 
quartal 

trimestre 
siguiente 

trimestre 
següent 

prossimo,trimestre 
nästa 
kvartal 

1 quarter 
ago 

 
il y a 1 
trimestre 

vor 1 quartal 
hace 1 
trimestre 

fa 1 trimestre 1 trimestre fa 
1 kvartal 
sedan 

x quarters 
ago 

2 - 4 
il y a x 
trimestres 

vor x 
quartalen 

hace x 
trimestres 

fa x trimestres x trimestri fa 
x kvartaler 
sedan 

In 1 quarter  
dans 1 
trimestre 

in 1 
quartalen 

en 1 trimestre en 1 trimestre in 1 trimestre 
om 1 
kvartal 

In x quarters 2 - 4 
dans x 
trimestres 

in x 
quartalen 

en x trimestres 
en x 
trimestres 

in x trimestri 
om x 
kvartaler 

Last Qx 1 - 4 dernier Tx letztes Qx anterior Tx anterior Tx Tx scorso förra Kx 

Next Qx 1 - 4 prochain Tx nächstes Qx siguiente Tx següent Tx Tx prossimo nästa Kx 

Qx 1990  to 
Qx 2030 (*) 

1 - 4 
Tx 1990 to  
Tx 2030 

Qx 1990 to 
Qx 2030 

Tx 1990 to  
Tx 2030 

Tx 1990 to 
Tx 2030 

Tx 1990 to 
Tx 2030 

Kx 1990 to 
 Kx 2030 

(*) For version 10.x and 11.0 the year range was 2004-2013, the new range 1990-2030 applies to versions 11.1 and greater. 
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7.8. Other Year Functions by Language 

Invariant 
and English 

Range 
for x 

French German Spanish Catalan Italian Swedish 

YEARS   ANNEES JAHREN AÑOS ANYS ANNI ÅR 

last year  an dernier Letztes Jahr 
año pasado / 
año anterior 

any passat / 
any anterior 

anno scorso  förra året 

this year  cette année Dieses Jahr 
este año /  
año actual 

aquest any / 
any actual   

quest anno detta året 

next year  an prochain Nächstes Jahr 
año próximo / 
año siguiente 

proper any / 
any següent  

anno 
prossimo 

nästa året 

0 years ago  /  
this year 

 
il y a 0 ans / 
cette année 

Vor 0 Jahr / 
Dieses Jahr 

hace 0 años / 
este año /  
año actual 

fa 0 anys / 
aquest any / 
any actual 

0 anni fa / 
quest anno 

0 år sedan / 
detta året 

1 year ago   /   
last year 

 
il y a 1 an  /   
an dernier 

Vor 1 Jahr /  
Letztes Jahr 

hace 1 año / 
año pasado 

fa 1 any / any 
passat / any 
anterior 

1 anno fa / 
anno scorso 

1 år sedan / 
förra året 

x years ago 2 - 10 il y a x ans Vor x Jahren hace x años fa x anys x anni fa x år sedan 

in 0 years    /   
this year 

 
dans 0 ans / 
cette année 

In 0 Jahren / 
Dieses Jahr 

en 0 años / 
este año /  
año actual 

en 0 anys / 
aquest any / 
any actual 

in 0 anni / 
quest anno 

om 0 år / 
detta året 

in 1 year    /   
next year 

 
dans 1 an  /  
an prochain 

In 1 Jahr / 
Nächstes Jahr 

en 1 año / año 
próximo 

en 1 any / 
proper any / 
any següent 

in 1 anno / 
anno 
prossimo 

om 1 år / 
nästa året 

in x years 2 - 10 dans x ans In x Jahren en x años en x anys in x anni om x års 

since 0 years 
/ since this 
year 

 
depuis 0 ans / 
depuis cette 
année 

Seit 0 Jahren / 
Seit Dieses Jahr 

desde 0 años 
/ desde este 
año 

des de 0 anys 
/ des d'aquest 
any 

da 0 anni  /  
da quest anno 

sedan 0 år / 
sedan detta 
året 

since 1 year / 
since last 
year 

 
depuis 1 an  / 
depuis l'an 
dernier 

Seit 1 Jahr / 
Seit Letztes 
Jahr 

desde 1 año / 
desde el año 
pasado 

des d'1 any / 
des de l'any 
passat 

da 1 anno  / 
da anno 
scorso 

sedan 1 år / 
sedan förra 
året 

last x years 2 - 10 depuis x ans Seit x Jahren desde x años des de x anys da x anni sedan x år 

until 1 year / 
until next 
year 

 

jusque dans 1 
an   / 
 jusqu'à l'an 
prochain 

Bis 1 Jahr / 
Bis Nächstes 
Jahr 

hasta 1 año / 
hasta el año 
próximo 

fins 1 any / 
fins el proper 
any 

fino a 1 anno / 
fino a anno 
prossimo 

till 1 år /  till 
nästa året 

until x years 2 - 10 
jusque dans x 
ans 

Bis x Jahren hasta x años fins x anys fino a x anni till x år 
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8. Technical Appendix 

Here are some technical information about shortcuts, URLs functions etc. 

8.1. Shorcut Pages 

Warning: all shortcuts have changed in version 2013 

 

Click&DECIDE Version 2013 

 

 

Shortcut Pages 

 

 

Old Shortcut Page 

 

Replace with 

/dvweb/Display.aspx 

 

/dvweb/Menus/ShowParameters.aspx 

/dvweb/Menus/Display.aspx 

/dvweb/Menus/Display.ashx 

/dvweb/Menus/Download.ashx 

/dvweb/WebQuery.ashx /dvweb/Menus/Query.ashx 

 

For compatibility reasons, old shortcuts are still supported but we recommend you to switch to the new syntax. 

 

8.2. Common Parameters 

 

 
Click&DECIDE Version 2013 

 

 
Common Parameters 

 

Shorcuts Description Old Name Type Unit/Values/Example 

__ca= 
Value for the 

Cache (1) 
  Integer Minutes 

__f= 
Output format 

name 
__format String 

PDF, HTML, Excel+XLS, ASCII, 

Excel+XLSX,Google+Data+Table etc 

__ma= Menu Alias __mnu_alias= String __ma=BAI+Demonstration 

__mi= Menu Iem ID __mnu_itemid= Integer __mi=2316 

__rp= Relative Path __relative_path= String __rp=Area+Chart+Sample.xgc 

__t= Type __type= String vision 

__it= Item Type __item_type= Integer (1 : query; 2 : report; 3: pivot; 4 : cube) 

__in= Item Name __item_name= String   

 

(1) Only concerns the Dashboard Applications (Query.ashx) 
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8.3. ShowParameters 

 

Show Parameters 

 

Function Description 
Supported 

Parameters 
Action Remarks 

ShowParameters.aspx 

/dvweb/Menus/ShowParameters.aspx? 

Show the 

parameter list 

for the selected 

item 

__sav=0 
shows the 

file 
  

__sav=1 
download the 

file 
  

__e=0 

displays 

parameters 

before 

running 

Old name: _exec= 

__e=1 

runs without 

showing 

parameters 

Old name: _exec= 

Note: if __e=1 and if a result 

already exists for the same 

query string, the result will be 

directly displayed. You need 

to click again the Run or 

Export button to reload the 

report or query. 

/dvweb/Menus/ShowParameters.aspx?__ma=BAI+Demonstration&__mi=2316  

 

8.4. Display 

 

Display 

 

Function Description Comment 

Display.aspx 

/dvweb/Menus/Display.aspx? 

Displays a runnable Menu item 

result with the navigation bar 

(Under a tablet or smartphone, no 

navigation bar is displayed). 

Note: in the case of a runnable item, if the result 

already exists, it will be directly displayed, if not it 

will be run without the possibility to cancel. To run 

directly an item with the possibility to cancel, you 

must use ShowParameters.aspx with the &__e=1 

/dvweb/Menus/Display.aspx?__ma=BAI+Demonstration&__mi=2558&__rp=Area+Chart+Sample.xgc  

Display.ashx 

/dvweb/Menus/Display.ashx? 

Displays a runnable Menu item 

result without the navigation bar, 

useful for drill-down/drill-up 

reports or Parent/Child 

Dashboards. 

Note: in the case of a runnable item, if the result 

already exists, it will be directly displayed, if not it 

will be run without the possibility to cancel. 

/dvweb/Menus/Display.ashx?__ma=BAI+Demonstration&__mi=2558&__rp=Dashboard+GC+Main.xgc 
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8.5. Download 

 

Download 

 

Functionalities Description Comment 

Download.ashx 

/dvweb/Menus/Download.ashx? Downloads a Menu Item or it result. 

Note: in the case of a runnable item, if 

the result already exists, it will be 

directly displayed, if not it will be run 

without the possibility to cancel. To run 

directly an item with the possibility to 

cancel, you must use 

ShowParameters.aspx with the 

&__e=1&__sav=1 

/dvweb/Menus/Download.ashx?__ma=BAI+Demonstration&__mi=2538&YEAR_PARAM=&SALNAME_PARAM=&PROD
REF_PARAM=&__f=PDF 

 

 

 

8.6. Query/WebQuery 

 

 

 

 

Query /WebQuery 

 

Function Comment 

Query.ashx 

/dvweb/Menus/Query.ashx? 

Returns the raw data 

from a Menu Item 

Result. 

Always run without the possibility to cancel. Use the 

&__ca=NN (minutes) to enable the browser cache in 

order to improve the performances. 

/dvweb/Menus/Query.ashx?__ma=BAI+Demonstration&__mi=2528&P_Year=&__f=Google+Data+Table 

/dvweb/Menus/Query.ashx?__ma=BAI+Demonstration&__mi=2528&P_Year=["P_Year","P_Year"]&__f=WebQuery 

WebQuery.ashx 

/dvweb/WebQuery.ashx? 
Returns the raw data 

from a Menu Item 

Result. 

Short version of Query.ashx used for WebQueries. Do 

not need the &__f=WebQuery flag. 

/dvweb/WebQuery.ashx?__ma=BAI+Demonstration&__mi=2528&P_Year=["P_Year","P_Year"] 

Note that for WebQuery URL longer than 255 characters, you can use the TinyURL describe in this User Guide page 57. 
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8.7. Share button shortcuts 

 

 

Copy Shortcut in the Share Button 

 

Parameters 

Checked Value Result 

No default The URL will not contain this parameter and the default value will be used for the query 

Yes 

Empty The URL will contain &PARAM= or &PARAM=["PARAM","PARAM"] for WebQueries 

default The URL will not contain this parameter and the default value will be used for the query 

other The URL will contain &PARAM=VALUE 
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